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This document is intended for use by RISO, its authorized dealers and purchasers

of the equipment described herein. While every effort has been made to insure the

accuracy of information contained in this document, RISO, its authorized dealers

and their employees shall not be held responsible for any inaccuracies it may

contain.

ALL SPECIFICATIONS ARE SUBJECT TO CHANGE WITHOUT NOTICE.

Reproduction or copying of this manual or any parts there of without permission is

strictly prohibited.

Although every effort has been made to ensure that the contents of this manual are

error-free, please contact us if you notice any errors or other points whitch should be

brought to the company’s attention.

Copyright © 2001 RISO KAGAKU CORPORATION, JAPAN

NOTE: Microsoft® and Windows® are registered trademarks of Microsoft Corporation.
Product names and company names that are referenced in this manual are (regis-
tered) trademarks of the respective companies.
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Preface

Thank you for purchasing the RISO Color Separation Software CS-2000.

This product is the application software tool which is specially designed for assisting you to produce multi-colored prints on

your RISO printer and enables you to print a specified area of your document in a desired color, viewing the print finish on

your PC screen.

In this user's guide, you can find detailed descriptions about how to install CS-2000 into your PC and use it to produce multi-

colored prints.

Read through this guide before using the CS-2000 or whenever you have questions in operations.

Package Contents
Check that your CS-2000 package contains the following components. If there are any missing components, contact your

service representative.

Software CD-ROM .................................1

User's guide ...........................................1

End user license agreement sheet ...........1

Preface

Open the “Readme” file which is stored in the software CD-ROM and read it through before using the CS-2000
because it contains additional points to be noted in using this application software.

NOTE:

3Preface

System Requirement
The following system is required at least to produce multi-colored prints, using the CS-2000.

• PC Requirement

OS: Microsoft Windows95 (Internet Explorer ver.4.0 or over is required) ,Windows 98, Windows Me

or Windows 2000 Professional

Memory: 32MB or more

Monitor: 800 x 600 pixels or more

* The color range is required to be “High Color (16 bit)” <60,000 colors> or more.

Free hard disk space: 5MB or more

NOTE : If ink palette colors are not displayed correctly in your PC screen, change the graphic driver type or its setting.

• Other Requirements

Printer controller: RISO SC3000 Series (SC3000/SC3500)
NOTE : RISO SC7000 Series are not available.

Printer: RISO printers with dedicated color cylinders (drums)
NOTE : • The above-listed printer controller is required only when the printer concerned is not equipped with a built-in one.

• Individual color cylinders (drums) are required for the respective ink palette colors applied in your document.
• If you apply another network interface device than the RISO-brand one to your RISO printer to enable data printout

on network, make sure that the selected device can accept FTP data.
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Product Features

The CS-2000 is the application software tool which is specially designed for assisting you to produce multi-colored prints on

your RISO printer.

Using this tool, you can paint your PC document with desired colors, checking the print finish on a selected color sheet on

your PC screen, and thus produce attractive colorful brochures or direct mails in simple steps.

Product Features

Feature 1

Application-free_______

You can paint any document file which is created on your PC in this tool, regardless

of the application software types, by converting it into a dedicated RISORINC-

format one.

Feature 2

Direct color entry

You can paint your PC document with desired colors directly on your PC screen as

if you painted a picture on a canvas with a paint can.

Feature 3

Timely job instructions based on auto color grouping _______

Simple job instructions, such as cylinder (drum) replacement and paper loading,

are given on your PC screen for easier multi-color printing during operation, auto-

matically preparing a different master on your RISO printer for the respective differ-

ent colors applied in your document.

NOTE: You can not edit characters or images themselves in this tool.
Individual RISO printer color cylinders (drums) are required for the respec-
tive ink palette colors applied in your document, and different color printing
paper for the respective paper palette colors, when printing on your RISO
printer.

8 CS-2000 Editing Window

CS-2000 Editing Window

You can paint your document file with desired colors, using paper and ink color palettes and various editing tools in

the CS-2000 editing window.

The appearance of your finished document can be viewed on your PC screen during operation as shown below.

Thumbnail
Click on the corresponding page
image box to display it in the Im-
age view zone for color editing.
All page images to be edited are
displayed here.
Select a desired one.

Tool Bar � P.10
Main functions can be
activated by clicking
on the buttons here.

Paper Palette � P.18
Standard paper colors are dis-
played here. Select a desired
one.

Image View Zone
You can view the current
color-applied page image
here.

Status Bar � P.11
The information about the
current editing window is
given here.

Toolbox � P.12
A desired editing tool can be selected
by clicking on a tool button here.

Ink Palette � P.18
All ink colors available
on the RISO printer are
displayed here.
Selects a desired one.
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Mult-icolor Printing Operation Flow

0.Setup your PC

� P.32

1.Create a document

file on your PC
� P.14

2.Convert the file format

into “RISORINC”
� P.14

You are required to install the CS-

2000 into your PC.

If your printer or an external printer

controller is connected to your PC

for the first time, install the dedicated

printer driver into your PC as well in

this step.

Refer to the dedicated user’s guide

for the installation procedures of the

printer driver.

NOTE : You can skip this step in
the following multi-color
print jobs once you set up
your PC as described
above.

You can use any application

software to create this document

file.

You are required to convert the print

data into “RISORINC” format.

The RISORINC-format files (job files)

are only applicable for color application

in the CS-2000.

NOTE : The job files made with the
RISORINC-100 (the former
version of RISO Color
Separation Software) cannnot
be used with CS-2000.

Multi-color Printing Operation Flow 7

Different masters are to be made for the

respective ink palette colors applied in

your job file.

NOTE: The available ink or paper
palette colors depend on what
color cylinder (drum) or
printing paper is prepared for
your printer.

Turn on your printer and load pa-

per. (Then turn on the external

printer controller, if connected.)

Install the cylinder (drum) whose

color is first specified into your printer

and print.

Replace the existing cylinder (drum)

with another one whose color is sec-

ondly specified and print.

Repeat this procedure until printing

your document in the color finally

specified.

NOTE: You can print in 2 colors
on a twin-cylinder (-drum)
printer at a time.

For detailed descriptions about the

operation of the RISO printer, refer

to the dedicated user's guide.

Multi-color Printing Operation Flow

3.Apply desired colors
to the job file in the
CS-2000
� P.18

4.Set up your RISO

Printer.
� P.19

5.Print the job file in

specified colors.
� P.19
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Product Features
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CS-2000 Editing Window

You can paint your document file with desired colors, using paper and ink color palettes and various editing tools in

the CS-2000 editing window.

The appearance of your finished document can be viewed on your PC screen during operation as shown below.

Thumbnail
Click on the corresponding page
image box to display it in the Im-
age view zone for color editing.
All page images to be edited are
displayed here.
Select a desired one.

Tool Bar � P.10
Main functions can be
activated by clicking
on the buttons here.

Paper Palette � P.18
Standard paper colors are dis-
played here. Select a desired
one.

Image View Zone
You can view the current
color-applied page image
here.

Status Bar � P.11
The information about the
current editing window is
given here.

Toolbox � P.12
A desired editing tool can be selected
by clicking on a tool button here.

Ink Palette � P.18
All ink colors available
on the RISO printer are
displayed here.
Selects a desired one.
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 File

Open � P.10

Save � P.10

Save As Saves the currently-edited job file as a new color document file, keeping the original

job file.

Print � P.10

Exit Exits the CS-2000 program.

Edit

Undo � P.10

Redo � P.10

Ink Settings � P.29

Tools

Object Fill � P.12

Rectangle Fill � P.12

Free Hand Fill � P.12

Zoom � P.12

Eraser � P.13

Object Eraser � P.13

Rectangle Eraser � P.13

Free Hand Eraser � P.13

View

Toolbar � P.10

Status Bar � P.11

Thumbnail � P.8

Toolbox � P.12

Ink Palette � P.18

Paper Palette � P.18

Zoom � P.12

About

About CS-2000 Indicates the version and serial numbers of the current CS-2000 program.

Features in CS-2000 Editing Window

Menu Bar

CS-2000 Editing Window

Any function available in the CS-2000 can be activated by selecting it from the pull-

down menus.

12

Selects the [Object Fill] icon, which appears on the screen in place of the mouse

pointer when it is placed on the page.

With this tool, you can fill an object with a color selected from the Ink color palette.

To apply a selected color to a specified object, place this icon inside the object and

then click. The specified object is then painted in the selected ink color.

1. Object Fill

4. Zoom

3. Free Hand Fill

2. Rectangle Fill Selects the [Rectangle Fill] icon, which appears on the screen in place of the mouse

pointer when it is placed on the page.

You can paint all images placed within the rectangle developed by clicking and drag-

ging this icon in a color selected from the Ink color palette.

To apply a selected color to the images, place the mouse pointer inside the rectangle

and then click. The mouse pointer is changed to the [Object Fill] icon when it is placed

inside the rectangle.

Selects the [Free Hand Fill] icon, which appears on the screen in place of the mouse

pointer when it is placed on the page.

You can paint all images placed within the free-hand-drawn closed line developed by

clicking and dragging this icon in a color selected from the Ink color palette.

To apply a selected color to the images, place the mouse pointer inside the closed

line and then click. The mouse pointer is changed to the [Object Fill] icon when it is

placed inside the closed line.

Selects the [Zoom] icon, which appears on the screen in place of the mouse pointer

when it is placed on the page.

You can zoom in or out the page image by clicking this icon on the page. To zoom in,

simply click the left mouse button. To zoom out, on the other hand, click the left

mouse button while pressing the [Ctrl] key. The page image can be zoomed in and

out at any of six scales, i.e. 1:1, 1:2, 1:4, 1:8, 1:16 and 1:32.

You can also select a scale from [Zoom] in the [View] menu on the Menu Bar.

NOTE : The performance speed in editing varies depending on the selected scale as
follows.
(Fastest) 1:1 > 1:32 > 1:16 > 1:8 > 1:4 > 1:2 (Slowest)

A desired editing tool can be selected by clicking on a tool button arranged in this box.

The following functions are assigned to the respective tool buttons.
Toolbox

� P.18

� P.18

� P.18

CS-2000 Editing Window
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Main functions can be instantly activated by clicking on the tool buttons arranged in

this bar.

The following functions are assigned to the respective tool buttons.

Opens the [Open] dialog box, in which you can select a job file to be edited (**.prn) or

a color document file to be printed or modified (**.rmc).

1. Open

CS-2000 Editing Window

Tool Bar

Overwrites the original job file with the current one to save changes.

If you want to keep the original job file, select [Save as] in the [File] menu and save

the currently-edited job file as a new color document file.

Important !
The file extension can be changed from [.prn] to [.rmc] only when you select [Save as] to
save the current job file. Therefore, always select [Save as] when saving a virgin job file
(**.prn) as a color document file after initial color application, to allow a quick search for

color document files.

2. Save

3. Print Opens the [Print] dialog box, in which you can specify the print job of the color docu-

ment file created in the CS-2000.

4. Undo Cancels the operation which has just been performed to recover the previous condi-

tion.

5. Redo

21 4 5

3 6 7

Performs the operation which has been cancelled by the "Undo" function once more.

11

Opens/closes the [Ink Palette], from which you can select an ink color desired to be

applied to the images on the page displayed on the screen.

To select an ink color desired to be applied to the images, click on it in the [Ink

Palette].

NOTE : • Individual color cylinders (drums) are required for the respective ink colors
applied in your document.

• You can add custom ink colors to the [Ink Palette]. � P.27

Opens/closes the [Paper Palette], from which you can select a paper color desired to

be applied to the background of the page displayed on the screen.

To apply a desired paper color to the background of the displayed page, simply click

on it in the [Paper Palette].

By selecting the same paper color as of the printing paper to be used, you can find an

approximate appearance of printed copies on your PC screen beforehand.

NOTE : You can add custom paper colors to the [Paper Palette]. � P.27

CS-2000 Editing Window

6. Ink Palette

7. Paper Palette

The current location of the mouse pointer is displayed here.

(0.0mm) indicates the upper left corner of the page.

The current page view size in the Image view zone is displayed here.

The following information is given here;

- the current status of the editing window

- the current operation in progress

1 2

1. Mouse Pointer Location

2. Zoom Ratio

Status Bar
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Selects the [Eraser] icon, which appears on the screen in place of the mouse pointer

when it is placed on the page.

You can paint a desired image in the same color as of the base paper, causing it to be

erased from the page. To erase a spot image, place this icon on it and then click.

To erase images continuously, on the other hand, click and drag this icon on them.

5. Eraser

8. Free Hand Eraser

7. Rectangle Eraser

6. Object Eraser Selects the [Object Eraser] icon, which appears on the screen in place of the mouse

pointer when it is placed on the page.

You can fill a desired object with the same color as of the base paper, causing it to be

erased from the page. To erase a specified object, place this icon inside it and then

click.

Selects the [Rectangle Eraser] icon, which appears on the screen in place of the

mouse pointer when it is placed on the page.

You can paint all images placed within the rectangle developed by clicking and drag-

ging this icon in the same color as of the base paper, causing them to be erased from

the page. To erase the images, place the mouse pointer inside the rectangle and
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16 Creating a Job File

Select the [Print to File] option.

Select the [Print to File] option box in the [Print] dialog box.

NOTE : If this option box cannot be found in the [Print] dialog box, click on the [Prop-
erties] button and select [File] in the [Print to the following port] box.

Click on the [OK] button.

The [Print to File] dialog box then appears.

Specify the file name and directory, then click on the [OK] (or [Save]) button. The file

whose extension is [.prn] is created as a job file for the CS-2000 (RISORINC file).

3
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Creating a Job File

Creating a Job File

1

2

You are required to convert a document file created on your PC into a special-format

one (RISORINC file) to paint it in the CS-2000.

Select a document file.

You can select any document file created on your PC, regardless of the application

software types.

Important !

• The document file should be created in black and white. If colored images exist there,

they will be screened in dots when the file is converted for the CS-2000, preventing solid

color application.

• Different colors can only be applied to separate images. If images overlap each other,

only one color can be applied to them.

Open the document file and specify the print conditions in the

[Print] dialog box.

Select [Print] in the [File] menu to open the [Print] dialog box.

Make sure that [Printer] is set to your RISO printer or the dedicated printer controller

in this dialog box.

For detailed descriptions about how to specify the print conditions in this step, refer to

the dedicated user's guide for the printer driver.

NOTE : • The print condition data specified in this step are saved in the RISORINC file
and displayed in the CS-2000, as well as the document data themselves.

• Make sure that the [Collate] option box is not selected in the [Copies] field
before clicking on the [OK] button.
If multiple copies are specified for the current document file with this option
selected, the same page data will be repeatedly developed for each specified
copy in the CS-2000, increasing the file data volume.

15Creating a Job File

• When a document file created in black and white is selected ;

Choose [Mono-color (colour) Print] in the [Service] field on the [Guide] tab.

• When a colored document file is selected ;

Choose [Dual-color (colour) Print] in the [Service] field on the [Guide] tab and specify appropriate settings

in the [Coloring (Colouring)] field on the [Image] tab according to your coloring design on the CS-2000.

<Coloring Tips>

• When a colored object is outlined in black, select [RGB -> Color (Colour) 1 / B&W -> Color (Colour) 2]

for [Text/Line Art] if you want to paint the outline in another color than that of the inside.

• 3 different coloring patterns are available for color photo images. For details, refer to the user’s guide of

the corresponding printer driver.

• Colored images will be screened in dots when converted if their colors are lighter than a predefined

level, thus preventing solid color application.

• Colored texts will also be screened in dots in converted files unless the [To Solid-look] option is selected

in the [Text/Line Art Processing] field on the [Image] tab when specifying the print conditions.

• Images will be painted in the print colors specified in the [Properties] dialog box of the printer driver

beforehand when you open a converted file on the CS-2000, thus providing you with a preview of the

print result under the given print conditions.
NOTE : Only when you select “Custom” as print color in the [Properties] dialog box of the printer driver,

the color data will be ignored, causing the corresponding images to be painted in black but not in
the selected “Custom” color on the CS-2000.

Requirements in Specifying Print Conditions for Twin-Cylinder (-Drum) Printer
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Selects the [Eraser] icon, which appears on the screen in place of the mouse pointer

when it is placed on the page.

You can paint a desired image in the same color as of the base paper, causing it to be

erased from the page. To erase a spot image, place this icon on it and then click.

To erase images continuously, on the other hand, click and drag this icon on them.

5. Eraser

8. Free Hand Eraser

7. Rectangle Eraser

6. Object Eraser Selects the [Object Eraser] icon, which appears on the screen in place of the mouse

pointer when it is placed on the page.

You can fill a desired object with the same color as of the base paper, causing it to be

erased from the page. To erase a specified object, place this icon inside it and then

click.

Selects the [Rectangle Eraser] icon, which appears on the screen in place of the

mouse pointer when it is placed on the page.

You can paint all images placed within the rectangle developed by clicking and drag-

ging this icon in the same color as of the base paper, causing them to be erased from

the page. To erase the images, place the mouse pointer inside the rectangle and

then click. The mouse pointer is changed to the [Object Eraser] icon when it is placed

inside the rectangle.

Selects the [Free Hand Eraser] icon, which appears on the screen in place of the

mouse pointer when it is placed on the page.

You can paint all images placed within the free-hand-drawn closed line developed by

clicking and dragging this icon in the same color as of the base paper, causing them

to be erased from the page. To erase the images, place the mouse pointer inside the

closed line and then click. The mouse pointer is changed to the [Object Eraser] icon

when it is placed inside the closed line.

16 Creating a Job File

Select the [Print to File] option.

Select the [Print to File] option box in the [Print] dialog box.

NOTE : If this option box cannot be found in the [Print] dialog box, click on the [Prop-
erties] button and select [File] in the [Print to the following port] box.

Click on the [OK] button.

The [Print to File] dialog box then appears.

Specify the file name and directory, then click on the [OK] (or [Save]) button. The file

whose extension is [.prn] is created as a job file for the CS-2000 (RISORINC file).

3
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Opening a Job File

1

You are required to open a dedicated-format document file (RISORINC file) from the

CS-2000 to paint the document on your PC screen.

Start the CS-2000.

Select [CS-2000] in the [RISO Color Separation] group in the [Programs] folder un-

der the [Start] menu.

Select a desired job file and click on the [Open] button.

Select a document file whose extension is [.prn]. (See the previous page.)

Open the [Open] dialog box.

Select [Open] in the [File] menu.

NOTE : • The file to which colors have already been applied on the CS-2000 (, whose
extension is [.rmc]) can also be selected.

• The job files made with the RISORINC-100 (the former version of RISO
Color Separation Software) cannot be used on the CS-2000.

2

3

Opening a Job File20 Printing a Job File

Select a print job flow.

[Auto Print] and [Manual Print] are prepared as print job flow. Click on the corre-

sponding radio button in the [Print Dialog] tab to select either of them.

When you select [Auto Print];

The Print job process will be set automatically to make the job as efficient as possible

in accordance with the color application on the respective pages in the current print

job. In this case, you have only to follow the instructions given along the job flow to

finish the current print job.

When you select [Manual Print];

The index icons appear on the corresponding color cylinder (drum) icons to indicate

the contents of the first-round print operation. If you want to change the print color(s)

and/or the page to be printed in the first-round operation, click the right-hand mouse

key on a desired color cylinder (drum) icon for a desired page and select a desired

print cylinder from the displayed list. The index icon will then be shifted onto the

specified cylinder (drum) icon.

NOTE : When you select a twin-cylinder (-drum) printer in the [Printer List] box, two
index icons, which are numbered “1” and “2”, appear to indicate the print
colors to be assigned to each print cylinder (drum). If you want to exchange the
print color between the print cylinder (drum) 1 and 2, besides, click the right-
hand mouse key on the index icon and select another print cylinder from the
displayed list.

5

Check the current print conditions.

Open the [Print Settings] tab and change the given settings, if required. For detailed

descriptions about the respective print conditions, refer to page 24.

6

[Auto Print] [Manual Print]
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Applying Colors to a Job File

1

2

Select a desired paper color.

Open the [Paper Palette] by clicking on the [Paper Palette] tool button and click on a

desired paper color in the palette. The desired paper color will then be applied to the

background of the sheet displayed in the editing window.

Select a desired ink color.

Open the [Ink Palette] by clicking on the [Ink Palette] tool button and click on a desired

ink color in the palette.

Specify the images to which the selected ink color is to be applied.

Select one of the following three area definition tools from the Toolbox.

� P.12

Specify desired images, using the selected tool, and click on them. The selected ink

color will then be applied to them in the editing window.

Repeat this operation until all images are painted as you desire.

Save the painted job file as a color document file.

Select [Save as] in the [File] menu to create a new file.

The file whose extension is [.rmc] is created as a color document file for multi-color

printing on the RISO printer.

NOTE : You are advised to select [Save] only when overwriting the existing color docu-
ment file ([.rmc]) after modification.

3

4

Applying Colors to a Job File 19

4 Specify the printer model to be used for the current print job.

Click on the [�] bar in the [Printer List] box in the [Print Dialog] tab and select the

printer (or printer controller) model which was specified when creating the current job

from the displayed list.

Follow the procedures given below to produce multi-color prints on the RISO printer

from the CS-2000.

You are advised to prepare all color cylinders (drums) and printing paper required for

this print job before the operation.

Turn on the printer and load paper.

Load paper whose size and color are the same as specified in the color document file

to be printed.

Turn on the printer controller, if connected, and start the CS-2000.

Open a color document file [.rmc] to be printed and click on the

[Print] tool button.

The [Print] dialog box then appears, showing the color cylinders (drums) required for

the current print job beside the corresponding print preview.

Printing a Job File

1

3

12

Printing a Job File
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Opening a Job File

1

You are required to open a dedicated-format document file (RISORINC file) from the

CS-2000 to paint the document on your PC screen.

Start the CS-2000.

Select [CS-2000] in the [RISO Color Separation] group in the [Programs] folder un-

der the [Start] menu.

Select a desired job file and click on the [Open] button.

Select a document file whose extension is [.prn]. (See the previous page.)

Open the [Open] dialog box.

Select [Open] in the [File] menu.

NOTE : • The file to which colors have already been applied on the CS-2000 (, whose
extension is [.rmc]) can also be selected.

• The job files made with the RISORINC-100 (the former version of RISO
Color Separation Software) cannot be used on the CS-2000.

2

3

Opening a Job File20 Printing a Job File

Select a print job flow.

[Auto Print] and [Manual Print] are prepared as print job flow. Click on the corre-

sponding radio button in the [Print Dialog] tab to select either of them.

When you select [Auto Print];

The Print job process will be set automatically to make the job as efficient as possible

in accordance with the color application on the respective pages in the current print

job. In this case, you have only to follow the instructions given along the job flow to

finish the current print job.

When you select [Manual Print];

The index icons appear on the corresponding color cylinder (drum) icons to indicate

the contents of the first-round print operation. If you want to change the print color(s)

and/or the page to be printed in the first-round operation, click the right-hand mouse

key on a desired color cylinder (drum) icon for a desired page and select a desired

print cylinder from the displayed list. The index icon will then be shifted onto the

specified cylinder (drum) icon.

NOTE : When you select a twin-cylinder (-drum) printer in the [Printer List] box, two
index icons, which are numbered “1” and “2”, appear to indicate the print
colors to be assigned to each print cylinder (drum). If you want to exchange the
print color between the print cylinder (drum) 1 and 2, besides, click the right-
hand mouse key on the index icon and select another print cylinder from the
displayed list.

5

Check the current print conditions.

Open the [Print Settings] tab and change the given settings, if required. For detailed

descriptions about the respective print conditions, refer to page 24.

6

[Auto Print] [Manual Print]
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NOTE : You can also check the current print job process in the [Print Schedule] tab in
advance, provided with required printing paper and color cylinders (drums)
along with print result previews, when you select [Auto Print] as print job
flow.

Click on the [Print] button in the [Print Dialog] tab.

The [Confirmation] message box appears, showing the printing paper and color cyl-

inders (drums) required for the first-round print operation along with the print result

preview. Confirm that the indicated printing paper and color cylinders (drums) are

prepared on your RISO printer.

NOTE : It is recommended to activate the Auto idling feature (if available) on the con-
trol panel of your RISO printer if the installed color cylinder (drum) is kept
idle for a long time. For detailed descriptions about the Auto idling feature,
refer to the user’s guide of your RISO printer.

7

24

You can check the print conditions of the current print job in the [Print Settings] tab of

the [Print] dialog box and, if required, change them.

Checking the Current Print Conditions

You can select the port to which image data are to be output. Click on the [�] bar in

the field below and select a desired output port from the displayed list.

File:

Outputs image data to a file. When you click on the [Print] button in the [Print Dialog]

tab, the [Save as] dialog box appears to allow you to specify the file name and

location.

LPT1/LPT2:

Outputs image data to a selected printer port, which is used when the printer is

directly connected to your computer with the printer cable.

[#.#.#.#] /lp (IP Address):

Outputs image data to the network printer whose IP address is selected here. The

IP addresses which are displayed here are required to be registered in this tab in

advance.

Output Port

Registering IP Addresses

You can register up to 10 IP addresses here.

To register an IP address, follow the procedure below.
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Prepare the printing paper and color cylinders (drums) for the

second-round print operation.

Check the printing paper and color cylinders (drums) required for the second-round

print operation in the [Confirmation] message box, which will be displayed again

when the first-round print operation has finished.

9

Click on the [OK] button in the message box.

The image data of the selected color(s) are transmitted to the printer to start the first-

round print operation, which will proceed in accordance with the Process setting in

the printer driver.

NOTE : For the detailed information on the Process setting, refer to the dedicated us-
er’s guide of your RISO printer.

8

When [Manual Print] was selected, however, the [Print] dialog box appears again

before the [Confirmation] message box, to request you to specify the print color(s)

and the page to be printed in the second-round print operation. Click on the [Print]

button to proceed to the [Confirmation] message box.

NOTE : A check mark is added to color cylinder (drum) icons in the [Print Dialog] tab
to indicate the corresponding page has already been printed in the marked
colors. If you are required to print the same page in the marked colors again
due to printer’s errors or wrong color cylinder (drum) preparation, click on the
[Clear print check marks] button in the [Print Dialog] tab to remove the check
marks and return the [Print Dialog] tab to the initial status.
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Repeat the operations described above to finish the current

multi-color print job.

NOTE : The current multi-color print job status is kept in the current color document
file until the color application status is modified in the file.
If you don't have enough time to finish your multi-color print job in the same
day, therefore, cancel the current print job and save your color document file.
When you open the same file later, you can continue your multi-color print
job from where you canceled it before.

11

Click on the [OK] button in the [Confirmation] message box.

The image data of the selected color(s) are transmitted to the printer again to start

the second-round print operation.

NOTE : When printed copies are loaded on the printer for the second-round print
operation, always confirm that they are placed in a correct direction and that
ink is dry enough on them to avoid ink smudges.

10
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11

Click on the [OK] button in the [Confirmation] message box.

The image data of the selected color(s) are transmitted to the printer again to start

the second-round print operation.

NOTE : When printed copies are loaded on the printer for the second-round print
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ink is dry enough on them to avoid ink smudges.
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NOTE : You can also check the current print job process in the [Print Schedule] tab in
advance, provided with required printing paper and color cylinders (drums)
along with print result previews, when you select [Auto Print] as print job
flow.

Click on the [Print] button in the [Print Dialog] tab.

The [Confirmation] message box appears, showing the printing paper and color cyl-

inders (drums) required for the first-round print operation along with the print result

preview. Confirm that the indicated printing paper and color cylinders (drums) are

prepared on your RISO printer.

NOTE : It is recommended to activate the Auto idling feature (if available) on the con-
trol panel of your RISO printer if the installed color cylinder (drum) is kept
idle for a long time. For detailed descriptions about the Auto idling feature,
refer to the user’s guide of your RISO printer.

7
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You can check the print conditions of the current print job in the [Print Settings] tab of

the [Print] dialog box and, if required, change them.

Checking the Current Print Conditions

You can select the port to which image data are to be output. Click on the [�] bar in

the field below and select a desired output port from the displayed list.

File:

Outputs image data to a file. When you click on the [Print] button in the [Print Dialog]

tab, the [Save as] dialog box appears to allow you to specify the file name and

location.

LPT1/LPT2:

Outputs image data to a selected printer port, which is used when the printer is

directly connected to your computer with the printer cable.

[#.#.#.#] /lp (IP Address):

Outputs image data to the network printer whose IP address is selected here. The

IP addresses which are displayed here are required to be registered in this tab in

advance.

Output Port

Registering IP Addresses

You can register up to 10 IP addresses here.

To register an IP address, follow the procedure below.
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You can store the image data transferred to the printer as a file there by selecting

“Print & Storage” or “Storage Only” in this section, if the optional Storage memory

card is installed in a selected printer. For detailed information on the Storage memory

card, refer to the user’s guide of the selected printer.

Print Only:

To print image data immediately after data output without keeping them in the stor-

age memory.

Print & Storage:

To print image data while keeping them in the storage memory.

Storage Only:

To keep image data in the storage memory without printing them.

The stored image data can be retrieved from the memory and repeatedly printed

out on the printer. They can be identified on the printer by their original file name and

source computer name which are to be given as default.

As the original file name is given to all the image data that are transferred to the

printer from an identical source color document file if the given name is not changed

for the respective data, it is recommended to select [Manual Print] as print job flow

and change the ID name displayed in the [ID Name ] field in this section before

transferring the respective image data to the printer to allow the easy identification of

their print colors from the ID names.

NOTE :  You cannot use the following characters for the ID name: / : , ; * ? " < > |

Storage Function

1. Click on the [�] bar in the field below and select “[0.0.0.0]/lp” from the dis-

played list.

2. Enter an IP address to be registered in the [IP Address] field.

3. Click on the [Register] button.

You can add an ID word, such as a printer name, to the displayed IP address by

entering it into the [Comment] field, thus allowing you to identify the correspond-

ing network printer easily.

Important !

Do not change the given word, i.e. “lp”, in the [Port] field. If print errors occur with

another brand network interface device, however, it may be required to be changed.

In this case, consult the dedicated user’s guide or the manufacturer of the device

concerned.

NOTE : Contact your network administrator for the IP addresses of desired net-
work printers.

28 Registering Custom Colors

4

1

2

3

Click on the [Custom] tab in a desired color palette.

You can select either the Paper palette or the Ink palette.

Click on the [...] button.

The [Register Color] dialog box appears.

Specify a base color combination for a custom color.

Slide the pointers on the respective base color scale bars according to the color

combination data of the custom color to be registered. You can check the result of the

specified base color combination in the color preview to the right.

NOTE : You can slide the pointer on the scales ranging from “0” to “255”. If you press
an arrow key on the keyboard, the pointer will be shifted on the scales step by
step.

Define a custom color name.

Delete the default name and enter a new one in the name field.

Click on the [Register] button.

The specified custom color is registered and shown in the [Custom] tab in the selected

color palette.

NOTE : To cancel this operation, click on the [Cancel] button instead.

5
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Display a message before deleting data:

A confirmation message box will appear before deleting the image data from the

storage memory of the printer when this check box is marked.

The settings which were specified in the printer driver when creating the current job

file are automatically applied to the respective items in this selection. You can change

them if required before transferring image data to the printer.

For detailed descriptions about the respective items in this section, refer to the user’s

guide of the corresponding printer driver.

Print Options

Checking the Current Print Conditions 27

Registering Custom Colors

You can register custom colors in both Paper and Ink palettes in addition to the

prepared ones.

Important !

The custom colors cannot be deleted from the palette once registered. Therefore, always

make sure they are correctly named based on the specified base color combination.

NOTE: • The maximum number of custom colors that can be registered in the respec-
tive palettes is as follows: 57 colors for paper and  64 for ink.

• The custom colors registered here will be added to the corresponding color
palette of another CS-2000 if a color document file which is painted in the
said custom colors is opened on it.

Registering Custom Colors

Paper Palette

Several typical paper colors are prepared as paper icons in the [Standard] tab for

instant use.

If the color of the paper you intend to use for your print job is not found there, however,

you can register it in the [Custom] tab to apply it as page background color on your

PC screen.

For detailed descriptions about how to create a new paper color, refer to the next

page.

Ink Palette

All standard ink colors which are available on the RISO printer are prepared in the

[Standard] tab for instant use.

If you intend to use a custom-ordered ink for your print job, however, you can register

it in the [Custom] tab to apply it to images on your PC screen.

For detailed descriptions about how to create a new ink color, refer to the next page.

NOTE : Individual color cylinders (drums) are required for the respective ink colors.
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You can store the image data transferred to the printer as a file there by selecting

“Print & Storage” or “Storage Only” in this section, if the optional Storage memory

card is installed in a selected printer. For detailed information on the Storage memory

card, refer to the user’s guide of the selected printer.

Print Only:

To print image data immediately after data output without keeping them in the stor-

age memory.

Print & Storage:

To print image data while keeping them in the storage memory.

Storage Only:

To keep image data in the storage memory without printing them.

The stored image data can be retrieved from the memory and repeatedly printed

out on the printer. They can be identified on the printer by their original file name and

source computer name which are to be given as default.

As the original file name is given to all the image data that are transferred to the

printer from an identical source color document file if the given name is not changed

for the respective data, it is recommended to select [Manual Print] as print job flow

and change the ID name displayed in the [ID Name ] field in this section before

transferring the respective image data to the printer to allow the easy identification of

their print colors from the ID names.

NOTE :  You cannot use the following characters for the ID name: / : , ; * ? " < > |

Storage Function

1. Click on the [�] bar in the field below and select “[0.0.0.0]/lp” from the dis-

played list.

2. Enter an IP address to be registered in the [IP Address] field.

3. Click on the [Register] button.

You can add an ID word, such as a printer name, to the displayed IP address by

entering it into the [Comment] field, thus allowing you to identify the correspond-

ing network printer easily.

Important !

Do not change the given word, i.e. “lp”, in the [Port] field. If print errors occur with

another brand network interface device, however, it may be required to be changed.

In this case, consult the dedicated user’s guide or the manufacturer of the device

concerned.

NOTE : Contact your network administrator for the IP addresses of desired net-
work printers.

28 Registering Custom Colors
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Click on the [Custom] tab in a desired color palette.

You can select either the Paper palette or the Ink palette.

Click on the [...] button.

The [Register Color] dialog box appears.

Specify a base color combination for a custom color.

Slide the pointers on the respective base color scale bars according to the color

combination data of the custom color to be registered. You can check the result of the

specified base color combination in the color preview to the right.

NOTE : You can slide the pointer on the scales ranging from “0” to “255”. If you press
an arrow key on the keyboard, the pointer will be shifted on the scales step by
step.

Define a custom color name.

Delete the default name and enter a new one in the name field.

Click on the [Register] button.

The specified custom color is registered and shown in the [Custom] tab in the selected

color palette.

NOTE : To cancel this operation, click on the [Cancel] button instead.
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Customizing the Ink Palette

You can customize the [Standard] tab in the Ink palette according to your print color

preparation as described below.

NOTE : It is required that no job file is opened on the CS-2000 when customizing the
Ink Palette.

1

3

Changing the Icon Arrangement

Click on the [Close] button.

The icon arrangement in the current [Standard] tab of the Ink palette will be changed

as specified.

2

You can change the arrangement of ink color icons in the [Standard] tab by deleting

the existing ones and/or adding reserved ones.

Click on [Ink Settings] in the [Edit] menu.

The [Setup Standard Inks] dialog box appears, showing all listed standard ink colors,

including reserved ones, with their base color combination data. The ink color icons

whose [Select] check box is marked are displayed in the [Standard] tab.

Click on the [Select] check box of a desired ink color icon.

If you want to display the selected ink color icon in the [Standard] tab, mark the

corresponding [Select] check box. If you want to delete the existing ink color icon

there, on the other hand, remove the check mark from the corresponding [Select]

box.

Customizing the Ink Palette32 Installing the CS-2000

You are required to install the RISO color separation software CS-2000 into your

computer to create color document files and print them on your RISO printer using its

various features.

Important !
• Close all other application software programs before installing this application

software.

• The dedicated printer driver program is also required to be installed in your
computer to print on the RISO printer using this application software. If not,
install it, referring to the user’s guide of the corresponding printer driver.

• If an old version of CS-2000 is already installed in your computer, uninstall it
before installing this version. To uninstall the CS-2000, use the uninstaller pro-
gram which is prepared in the CS-2000 software CD-ROM or the [Add/Re-
move Programs] tool in the [Control Panel] of the Windows. The uninstaller

program of the CS-2000 is available in the [Installation Wizard].

Turn on your personal computer and start Windows.

Insert the software CD-ROM and open the CD-ROM drive window.

Insert the dedicated software CD-ROM into the CD-ROM drive and open the CD-

ROM drive window in the Windows Explorer or in the [My Computer] window.

Double-click on the [Setup] file or icon in the CD-ROM drive window.

The [Installation Wizard] appears on the screen. Follow the instructions indicated

there to continue the installation operation.

Installing the CS-2000
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2

3



30 Customizing the Ink Palette

1

3

Click on [Ink Settings] in the [Edit] menu.

The [Setup Standard Inks] dialog box appears, showing all listed standard ink colors,

including reserved ones, with their base color combination data.

Changing the Color Appearance and Name of Icons

Select a desired ink color icon and click on the [Edit] button.

The [Register Color] dialog box appears.

Change the given base color combination.

Slide the pointers on the respective base color scale bars according to the color

combination data of the target color. You can check the result of the changed base

color combination in the color preview to the right.

NOTE : You can slide the pointer on the scales ranging from “0” to “255”. If you
press an arrow key on the keyboard, the pointer will be shifted on the scales
step by step.

4 Change the given color name.

Delete the existing name and enter a desired one in the name field.

2

You can change the color appearance and name of ink color icons in the [Standard]

tab to make the colored page view as real as possible by applying the print colors

which are actually available on the printer.

31

5 Click on the [Register] button.

The color appearance and name of the selected ink color icon will be changed as

specified in the [Setup Standard Inks] dialog box. If you want to change them in the

[Standard] tab in the Ink palette as well, besides, close the [Setup Standard Inks]

dialog box by clicking on the [Close] button.

NOTE : To cancel this operation, click on the [Cancel] button instead.

Customizing the Ink Palette
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You are required to install the RISO color separation software CS-2000 into your

computer to create color document files and print them on your RISO printer using its

various features.

Important !
• Close all other application software programs before installing this application

software.

• The dedicated printer driver program is also required to be installed in your
computer to print on the RISO printer using this application software. If not,
install it, referring to the user’s guide of the corresponding printer driver.

• If an old version of CS-2000 is already installed in your computer, uninstall it
before installing this version. To uninstall the CS-2000, use the uninstaller pro-
gram which is prepared in the CS-2000 software CD-ROM or the [Add/Re-
move Programs] tool in the [Control Panel] of the Windows. The uninstaller

program of the CS-2000 is available in the [Installation Wizard].

Turn on your personal computer and start Windows.

Insert the software CD-ROM and open the CD-ROM drive window.

Insert the dedicated software CD-ROM into the CD-ROM drive and open the CD-

ROM drive window in the Windows Explorer or in the [My Computer] window.

Double-click on the [Setup] file or icon in the CD-ROM drive window.

The [Installation Wizard] appears on the screen. Follow the instructions indicated

there to continue the installation operation.

Installing the CS-2000
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5 Check the destination of the program files to be installed and

click on the [Next] button.

If you prefer another destination, type it directly in the corresponding entry box or click

on the [Browse] button to specify it in the [Choose Folder] window. When you specify

another destination in the [Choose Folder] window, click on the [OK] button to close

the window.

4 Register user information.

Type in all fields, i.e. [User Name], [Company Name] and [Serial Number], in the

[Customer Information] window and click on the [Next] button.

NOTE : Enter the same number in the [Serial Number] field as printed on the software
CD-ROM case.

Installing the CS-200036 103-03007-100
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6 Finish the installation operation.

Follow the instructions indicated in a series of windows. The corresponding program

files are installed in the specified directory and the following message will then be

displayed to indicate all required files are successfully installed in your computer.

Click on [Finish] in this box and remove the software CD-ROM out of the CD-ROM

drive.

NOTE : Keep the software CD-ROM in a safe location.

Installing the CS-2000 35Troubleshooting Tips

Troubleshooting Tips

Check the points instructed below if you encounter the following operation problems. Contact your service representative for

help if you cannot solve the problem.

A job file cannot be opened. The selected job file was already edited in an old version

CS-2000.

Action:

Create another job file from the original document file.

Titles are not displayed correctly in the CS-2000 editing

window and dialog boxes.

The current system font size is not suitable for the CS-

2000 in your computer.

Action:

Change the system font size setting in your computer.

No custom color can be added to the Paper or Ink palette. The specified color name already exists in the palette.

Action:

Specify another name for the custom color to be added.

An edited color document file cannot be printed correctly. A wrong printer is selected in the [Printer List] box in the

[Print Dialog] tab of the [Print] dialog box.

Action:

Select a correct printer in the [Printer List] box and reprint.

Cause / Condition and ActionProblem
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